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ABOUT THIS COURSE
About This Course

This course provides you with the information you need to use
Prolog Manager™ 6.0’s advance reporting capabilities. This
course assumes you have already taken the Introduction to Prolog
Manager training course and that you are familiar with the
standard features of Microsoft Windows®-based computer
applications. It also assumes you are familiar with what a database
is and what it does.
This workbook teaches concepts and procedures by walking you
through common report use and modification tasks. It breaks the
tasks up into short, easy to understand segments. Training classes
using this workbook can combine hands-on learning, visual aids
and lecture.
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Course Objectives
When you complete this course, you will understand the workings of Prolog Manager’s
Report Manager and the basics of Seagate Crystal Reports®. You will know how to:
•

Run a system report with Prolog Manager’s Report Manager

•

Create a report using Prolog Manager’s Report Manager

•

Create a run-time filter for a Prolog Manager report

•

Change security settings on a Prolog Manager report

•

Modify a Prolog Manager report using Seagate Crystal Reports

•

Create a new report from scratch using Seagate Crystal Reports

•

Add a subreport to an existing report

Conventions in This Workbook
Prolog Manager may use different jargon and nomenclature from what your company uses
to describe the same process.
The following conventions are used throughout this book.

Lessons
Each lesson in the workbook is made up of tasks. Each task relates to a particular process
or element in Prolog Manager. The number of tasks varies from lesson to lesson.

Tasks
Each lesson contains several individual tasks, which are written in a two-column format.
The left column, or What do I do? contains numbered steps that list specific instructions,
such as words to type, specific keys to press, or commands to choose from the menus. The
right column, or What happens?/Comments, describes what is happening in the program,
reasons for the results you see, and pictures to help you identify certain elements of Prolog
Manager, such as toolbar buttons dialog boxes or forms.
Note: Notes point out special details that you should consider.

vi

Important:

Important notes point out details which, if ignored, could seriously
adversely effect your use of Prolog Manager.

A Cool Tool:

Cool Tools point out powerful Prolog Manager features that make your
work easier.

About This Course

Typographic Conventions
This book uses the following typographic conventions:
•

Frudiger bold type indicates the names of most elements of the user interface, such as
windows, dialogs, fields, rows, features and Wizards, as well as specific information
you enter into fields.

•

SMALL CAPS indicate the names of keyboard keys, such as TAB or CTRL.
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Lessons

1

Advanced Reporting with Prolog Manager 6.0

2

I n t r o d u c t i o n

Prolog Manager Basics

PROLOG MANAGER BASICS

Prolog Manager is project management and documentation
control software designed for the construction industry. Prolog
Manager is a user-friendly program that helps you control project
costs, streamline your paperwork and organize the details of your
construction project. Using Prolog Manager, you can concentrate
on your project and forget the hassles of constantly shuffling
paper.
The user interface in Prolog Manager 6.0 has been designed to
emulate Microsoft Office® products.
This introduction reviews basic information about Prolog
Manager databases and the Prolog Manager environment that is
essential to using advanced reporting features.
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About Prolog Manager 6.0 Databases
Prolog Manager 6.0 database files have the extension.mdf (Microsoft Database File). One
database file can contain multiple projects. Each database contains information about the
companies working on your projects contained in it, as well as materials used to build the
projects and progression of the projects themselves. You can set up Prolog Manager with
multiple .mdf files based on how you need the database to function for particular projects
or groups of projects. Each database may contain records and documents that are similar to
or different from other Prolog Manager databases.
Important:

Unless stated otherwise, for all the exercises in this book, log on to the
Prolog Sample Database as Admin and select the Downtown Medical
Center project.

Navigating the Main Prolog Manager Window
The main window in Prolog Manager contains several essential navigational elements. The
following sections briefly describe the Switchboard and toolbars in the main window.

Prolog Manager main window
Title bar
Menu
Toolbar

Switchboard

Switchboard
The Switchboard appears on the left side of the Prolog Manager window. When you click
a button on the Switchboard, a menu of forms appears. You use these forms to perform
tasks or functions related to those forms. You can view the Switchboard in two different
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modes: in normal view or in tree view.

Prolog Manager Switchboard in normal and tree views
Normal view

Tree view

Forms in the
Cost Control
group

The table below gives the function for each button on the Switchboard.

Button

Name

Function

Purchase

Opens the list of purchasing forms

Cost Control

Opens the list of cost controlling forms

Doc Control

Opens the list of forms related to
documentation

Field Admin

Opens the list of field administrative forms
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Button

Name

Function

Reports

Opens the list of reports

Admin

Opens the list of administrative forms

Toolbar
The buttons on the Standard toolbar, or simply “the toolbar,” give you access to the most
commonly used commands in Prolog Manager, such as opening a project, checking
spelling and printing reports. For a complete listing of each of the buttons on the toolbar,
see “Standard Toolbar” on page 128.

Using Form Buttons versus the Form Buttons toolbar
Several buttons called “form buttons” appear at the bottom of forms in Prolog Manager.
They include buttons to save, close, and add a record. You can also use these buttons via
the Form Buttons toolbar. The Form Buttons toolbar can either appear at the top of the
window or floating separately.

Form with buttons

Form Buttons toolbar in use

For a complete list of the buttons as they appear in the Form Buttons toolbar, see “Form
Buttons Toolbar” on page 131.
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Getting Help in Prolog Manager
To assist you in your use of Prolog Manager, several options are available to you, including
online help and Meridian Project Systems’ Technical Support department.

How Do I Contact Meridian Project Systems’ Technical Support?
•

Call (916) 294-2100 Monday-Friday, 5am-5pm PST

•

Visit SupportLink at Meridian Project Systems’ Web site at www.mps.com for
our Knowledge Base and Technical Documentation Library

•

Send faxes to (916) 294-2001, or e-mail tech@mps.com.

Note: Please have your serial number and version ready when you contact Technical
Support. To locate this information, on the Help menu, click About.

How Do I Access Prolog Manager Online Help?

1.

What do I do?

What happens?/Comments

On the Prolog Manager menu bar,
click Help, and on the submenu, click
Contents and Index.

The Online Help system appears:

How Do I Access the Prolog Manager User Guides?
Prolog Manger includes a User Guide and an Administrator Guide in .pdf format. To view
these Guides, you must have Adobe Acrobat Reader 3.0 or 4.0 on your computer. These
manuals are located on your hard drive in the folder: \\Program Files\Meridian\Prolog
WebSite6\Help\Documentation. You can also open them as follows:
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1.
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What do I do?

What happens?/Comments

On the Prolog Manager menu bar,
click Help, and on the submenu, click
Online Manuals.

Adobe Acrobat Reader opens and the
Online Manual system appears:

L e s s o n

1

REPORT MANAGER
Report Manager

Lesson Overview
This lesson describes the basic report modifications available in
Prolog Manager’s Report Manager. This chapter is essentially the
same as the Report Manager chapter of the Training Manual for
Introduction to Prolog Manager 6.0. In this lesson, you will
generate a system report and then create and customize a new
report. You will also create a report filter which prompts you for a
value when you run the report. This lesson includes the following
A. Using Report Manager
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B. Running System Reports
C. Creating a Report
D. Creating a Run-Time Record Filter

10

Lesson 1: Report Manager

A. Using Report Manager
Report Manager creates and generates reports. It searches your project database for records
which meet a set of criteria and then displays the information in an organized format.
Report Manager comes with a number of pre-defined reports. Using Report Manager, you
can customize these reports or create your own reports.
When you open Report Manager, you see the Reports tree displayed on the Reports Tree
tab. The Reports tree looks and works like Windows Explorer. You can click the plus sign
next to a folder to expand that part of the tree and see all of the folders or reports in that
branch of the tree. Click the minus sign next to a folder to collapse the branch and hide the
folders and reports.
The Reports tree always displays the three root folders: Public, Secure and System. Root
folders cannot be renamed, moved, or deleted. Root folders are used to organize predefined and custom reports. Reports in the Public folder are available to all users. Reports
in the Secure folder are available only to the person who created the report. Reports in the
System folder are the default reports created for Prolog Manager and are included in the
software you receive. When a user runs a report in the Secure folder or the System folder,
Security Manager checks the access rights of the user and only displays information the
user has been given access to see.
The following illustration identifies the main parts of the Reports tree.

Reports tree

Root folder
Folder
Reports

Yellow icons appear next to folders and reports beneath the Public folder and Secure folder.
Green icons appear next to folders and reports beneath the System folder.
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B. Running System Reports
When you run a report, Prolog Manager selects all the records in your database which
match a specified criteria and then displays the information in an organized format. The
System folder in Report Manager contains all the default reports for Prolog Manager.
Reports in the System folder cannot be modified.

Task B.1

How Do I Run a System Report?

In this task, you will run a system report.

What do I do?
1.

What happens?/Comments

On the toolbar, click Report
Manager.
The Report Manager opens.

2.

On the Reports Tree tab, click the +
(plus sign) next to the System folder.

Report Manager displays the System
reports subfolders.

3.

Click the + (plus sign) next to the
Doc Control folder.

The Doc Control report folders appear.

4.

Click the + (plus sign) next to the
HotList folder.

The HotList reports appear.

5.

Select the HotList Detailed,
Grouped by Type report.

The report title and subtitle appear at the
top of the Report Manager window.

6.

Click Run.

The Preview window opens and
displays the report.
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What do I do?
7.

What happens?/Comments

To see the entire report, set the view
to Page Width.

The report page appears resized so that
you can see the width of the page in the
Preview window.

8.

In the tree view, click 99-2045.

The tree expands to display the section
headers by which the items in the
report are subdivided:
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9.

What do I do?

What happens?/Comments

Click RFI.

The open report displays its RFI
section:

10. Click the Close button.
The Preview window closes.
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C. Creating a Report
In Prolog Manager you can create a report by copying and customizing an existing report.
If you want to customize a System report, you need to first copy the report from the System
report folder to the Public folder or Secure folder.
In this set of tasks, you will create a report folder and then copy and modify the report you
generated in Task B.1 on page 12. You are going to change the report so that the report
displays HotList items by type and responsibility. You will also specify the order that
records are sorted in the report and determine the appearance of the report.

Task C.1 How Do I Create a Report Folder?
In this task, you will create a new folder for your reports in the Public folder. The Public
folder contains customized or user-defined reports available to all users.

What do I do?
1.

In the Reports tree, click the Public
folder.

2.

At the bottom of the Report Manager
window, click Add Group.

What happens?/Comments

A new folder appears in the Public
folder called New Group.

3.

Clear the Name field and type:
Weekly Reports.

4.

Click Save.
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Task C.2 How Do I Create a Report from an Existing System
Report?
Now that you have a place to store your custom reports, you can copy a System report and
place it into the Weekly Reports folder. You cannot modify a System report, but if you
place a copy of the report into the Public or Secure folders, you can modify the copy of the
System report.

What do I do?

16

1.

In the Reports tree, click the System
folder, the Doc Control folder and
the HotList folder, so you can see the
HotList report list.

2.

Right-click the HotList Detailed,
Grouped by Type report, and on the
menu, click Copy.

3.

Right-click Weekly Reports folder
and select Paste on the shortcut
menu.

4.

Click Save.

What happens?/Comments

A copy of the HotList Detailed, Grouped
by Type report has been copied into the
Weekly Reports folder.

Lesson 1: Report Manager

Task C.3 How Do I Rename a Report?
Any of the reports in the Public or Secure folders can be renamed. In this task, you will
rename the copy of the HotList Detailed, Grouped by Type report you placed in the Weekly
Reports folder.

What do I do?
1.

In the Reports tree, select the copy of
the HotList Detailed, Grouped by
Type.

2.

Click the General tab.

3.

In the Title field, type: Our HotList.

4.

In the Subtitle field, type: Detailed,
Grouped by Type & Filtered by
Responsibility.

5.

In the Description field, delete the
existing description.

6.

In the Description field, type: Our
custom HotList report based on
type and responsibility.

7.

Click the Reports Tree tab.

What happens?/Comments

The new Title and Subtitle of the report
appear in the Reports Tree.
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What do I do?
8.

Click Save.

9.

Click Run.

What happens?/Comments

The report is generated. It appears with
the new title and subtitle.

10. In the Report viewer click Close to
close the report.
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Task C.4 How Do I Create a Record Filter?
Report Manager uses record filters to determine which project records are displayed in
reports. A record filter is an expression or set of expressions you create so that a report only
displays records which meet certain conditions. In this task, you will create a record filter
that selects HotList records for which Darin Miller of Acme Construction is the responsible
contact.

What do I do?

What happens?/Comments

1.

In the Reports Manager, click the
Designer tab.

2.

On the Record Filters tab, click the
next to the <Default> list.

A list of queries you can use to view tables
in the HotList: Main data group appears:

3.

Select <All>.

You want to view all the columns for the
HotList: Main data group.
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What do I do?
4.

In the Record Filters tree, click the +
(plus sign) next to the Responsible
Contact table.

5.

In the Record Filters tree, doubleclick Display Name.

What happens?/Comments

The Quick Filter dialog appears:

The Display Name column records the
name of the responsible contact for the
HotList records.
If you do not see the Quick Filter dialog,
make sure the Quick Filter check box on
the Designer tab is checked.

6.
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In the Operator list, make sure = is
displayed.

The Operator list displays the list of
possible algebraic relationships by which
you can filter:
=

Equal to

<>

Not equal to

>

Greater than

>=

Greater than or equal to

<

Less than

<=

Less than or equal to

Like

Approximately

Lesson 1: Report Manager

What do I do?
7.

In the Value list, select Darin Miller.

8.

Click OK.

9.

Click Save.

10.

Click Run.

11.

To close the preview window, click
Close.

What happens?/Comments

The expression appears in the grid on the
Record Filters tab.

The report appears in the Preview
window. The report only displays HotList
items assigned to Darin Miller.

Note: You can filter by any value listed in the Record Filters tab for that report. You can
select more than one filter and select Or or And to indicate whether you want to
select records with either or both criteria. For example, after you have selected
Darin Miller, you could select Andrew Forrest and indicate in the And/Or column
that you want items with either Darin or Andrew as the display name. Or, you
could only display Darin for the Display Name and also select Project Name =
Downtown Medical Center, and select And in the And/Or column only Darin’s
items for that project appear.
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Task C.5 How Do I Change the Sort Order?
You can determine the order in which records are sorted and displayed in a report. For this
report, you will set up the report to sort the Hotlist records by record number.

What do I do?

What happens?/Comments

1.

In the Reports Manager, click the
Order tab.

2.

In the Order tree, click the + (plus
sign) next to the Hot List table.

All of the columns in the Hot List table
appear.

3.

Scroll down until you see Number.

The Hot List.Number column appears in
the grid.

Double-click Number.

4.

In the Sort column, select
Descending.

The records will appear in descending
order based on the HotList item
number. Descending order sorts
records from Z–A and 9–1.
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5.

Click Save.

6.

Click Run.

7.

To close the preview window, click
Close.

The report appears in the Preview
window. HotList records are now sorted
from highest number to lowest number.
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Task C.6 How Do I Change a Column Name?
If you do not like the column name used in a report, you can change it. This is also referred
to as changing the run-time value. In this task, you will change the name of the Importance
column in the report to Priority.

What do I do?

What happens?/Comments

1.

In the Reports Manager, click the
Formula tab.

2.

In the Run-time Value column next
to Importance, type: Priority.

Priority will appear as the column header
instead of Importance.

3.

Click Save.

By clicking Save, you cause Priority to be
used instead of Importance every time the
Our Hotlist Detailed, Grouped by Type &
Responsibility report is generated.

4.

Click Run.

The report in the Preview window. The
Importance column is now the Priority
column.

5.

To close the preview window, click
Close.
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Task C.7 How Do I Use Footers and Logos?
In this task, you will customize the appearance of the report by adding and removing footers
and adding a logo.

What do I do?
1.

In the Reports Manager, click the
Options tab.

2.

Under Show, make sure the System
Footer check box.

What happens?/Comments

This check determines that the System
Footer will appear on the report. The
System Footer displays the date the
report was generated, and the database
used to generate the report.

3.

Under Show, select the User-defined
report footer check box.

Now a footer you create to appear on the
report.
Now you can enter text in the Userdefined report footer text box.
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4.

In the field under User-defined
Report Footer check box, type: My
Own HotList.

5.

Check Description.

Checking this box causes the text in the
Description field on the General tab to
appear at the bottom of the report.

Lesson 1: Report Manager

What do I do?
6.

What happens?/Comments

Under Logo, check Use Logo.

Now the logo will appear in the report.

7.

Click Save.

8.

Click Run.

9.

To close the preview window, click
Close.

10.

Click Close in the Report Manager
window.

The Preview window displays the Our
HotList Detailed, Grouped by Type &
Responsibility report.

Report Manager closes.
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HotList Detailed, Grouped by Type & Responsibility report
Logo
Report title
Report subtitle
Records sorted
in descending
order

Description

User-defined
report footer
System Footer
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D. Creating a Run-Time Record Filter
In Task C.4 “How Do I Create a Record Filter?” on page 19, you created a record filter for
a report. When you created the record filter, you specified the precise criteria or values you
wanted to see in the report. When you run the report, the report displays HotList items
assigned to Darin Miller of Acme Construction. However, you can also create a record filter
which prompts you for a value when you run the report. You select a value from a list of
existing values. You can select a different value each time you run the report.
In this set of tasks, you will create a new report by copying a System report, and then create
a run-time record filter for the report.

Task D.1 How Do I Create a Report from an Existing System
Report?
In this task, you will create a new report by copying a System report.

What do I do?
1.

What happens?/Comments

On the toolbar, click Report
Manager.
The Report Manager opens.

2.

On the Reports Tree tab, click the +
(plus sign) next to the System folder.

The System reports subfolders appear:

3.

Click the + (plus sign) next to the
Field Admin folder.

The subfolders in the Field Admin folder
appear.
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What do I do?

What happens?/Comments

4.

Click the + (plus sign) next to the
Daily Work Journal folder.

All the reports in the Daily Work Journal
folder appear:

5.

Right-click the Daily Construction
Work Detailed, Grouped by Date
report, and on the popup menu, click
Copy.

6.

Right-click the Public folder, and on
the popup menu, click Paste.

7.

In the Subtitle field, type: Filtered
by Date.

A copy of the Daily Construction Work
Detailed, Grouped by Date report
appears in the Public folder.

The Title and Subtitle of the report
appear in the Reports tree.

8.
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Click Save.

When you save the report, The color of
the report changes from blue to yellow.
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Task D.2 How Do I Create a Run-time Record Filter?
Report Manager uses record filters to determine which project records are displayed in
report results. A record filter is an expression or set or expressions you create so that a
report only displays records which meet the criteria specified in the expressions. When you
create a run-time record filter, you specify the criteria each time you run the report.
In this task, you will create a record filter for the date of the daily report.

What do I do?

What happens?/Comments

1.

On the Reports Tree tab, select the
Daily Construction Report Filtered
by Date report.

2.

Click the Designer tab.

3.

On the Record Filters tab, in the
Record Filters tree, click the + (plus
sign) next to the Daily Work table.

The columns in the Daily Work table
appear:

4.

Double-click Date.

The Quick Filter dialog appears:

If you do not see the Quick Filter dialog,
make sure the Quick Filter check box is
selected.
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What do I do?
5.

Make sure = is selected in the
Operators list.

6.

In the Value list, type: @@Date?

What happens?/Comments

When you run the report, “@@”
instructs Report Manager to prompt
you to select a date. “Date?” reminds
you what type of information you need
to select.

7.

Click OK.

8.

Click Save.

The expression appears in the grid on the
Record Filters tab.

Note: You can type in any text after @@, but make sure the text you type will remind
you what type of information to enter when you run the report.
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Task D.3 How Do I Run the Report?
In this task, you will run the report you just created and select the value you want to use to
filter the report.

What do I do?

What happens?/Comments

1.

On the Report Manager, click Run.

The Enter Values dialog appears:

2.

Click the Zoom button.
Report Manager displays a list of dates
for existing Daily Work Journal
entries.

3.

On the Values tab, select a date, and
click Select.
The selected date appears in the Enter
Values dialog.
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4.

What do I do?

What happens?/Comments

Click OK.

The report appears in the Preview
window.
The report only shows information for the
date you selected in the Enter Values
dialog.

5.

32

When you finish viewing the report,
close the Close to close the Preview
window.
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SECURITY
SECURITY
Security

Lesson Overview
In this lesson, you will use Security Manager to modify the reports
available through Prolog Manager and the information available
within a report.
A. Restricting Access to Reports

B. Restricting Access to Reports Data
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A. Restricting Access to Reports
Prolog Manager’s Report Manager contains over 400 system reports. These system reports
are available to all Prolog Manager users. This number is sufficiently large that it may be
confusing to users, causing them to generate the wrong reports. Some of them contain
information for which you want to restrict access.
Using the Security Manager, you can restrict access by any user group to individual reports
or to a whole group of reports tied to a specific form.
Prolog Manager come pre-configured with several user groups, but these are all configured
for collaborating team members who access Prolog Manager data through Prolog WebSite.
Therefore, in this task you will first log into Prolog Manager as Admin and create a new
user group. Then you will create profile for a person in that user group. Then, still as
Admin, you will restrict access to some reports and some data by a members of the user
group. Then you will log out and log in again as the new user to view how these changes
affect your access.
In this task you will create a test user group, remove its members’ permission from viewing
a few reports, and then assign a user to that group.

Task A.1 How Do I Set Up a New User Group?
What do I do?

What happens?/Comments

1.

Log in as Admin to the Prolog
Sample Database and the
Downtown Medical Center project.

The Admin user has persmission to
make all possible changes in Prolog
Manager.

2.

In the Tools menu, click Security,
and on the submenu, click Security
Manager.

The Security Manager opens:

All of the user groups starting with
Collaboration - are configured to use
Prolog Manager data through Prolog
WebSite. Of the pre-installed groups,
only User and Admin can enter Prolog
Manager directly.
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What do I do?

What happens?/Comments

3.

Click Add Group.

NewGroup appears.

4.

Change the Name field to read
TestGroup.

5.

Change the Description field to read
Test group to limit access to data
for reporting..

6.

Click Save.

7.

Click Yes.

A message asks if you wish to Commit
changes?
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Task A.2 How Do I Change Permissions for a User Group?
What do I do?

What happens?/Comments

1.

In the list of user groups, select
TestGroup.

Make sure you select it so it changes to
blue (rather than grey).

2.

Click the Feature Permissions tab.

The Feature Permissions list appears
with TestGroup in the Current User
Group field on the right.

Important:
The default for a
newly created group allows users in
this group the same permissions as
Admin. When you create a new
group, be sure to restrict access to
data as appropriate.
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3.

Click the + next to Report Manager.

4.

Click the + next to System Reports.

5.

Click the + next to System.

6.

Click the + next to Purchase.

7.

Click the + next to Addendum
Setup.

The tree expands to display the
subfolders.
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What do I do?

What happens?/Comments

8.

Click the green arrow next to
Addendum Setup.

change to red
The green arrows
indicators. In addition, the
No
green arrow next to the Purchase group
changes to a split circle
,
indicating the tree below contains both
of the other two symbols.

9.

Click the + next to Bid Packages.

10.

Click the green arrows next to the
bottom seven items beneath Bid
Packages, all beginning with Bid
Packages Summary.

11.

Click Save.

12.

Click Yes.

A message asks if you wish to Commit
changes?
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Task A.3 How Do I Add a User to a User Group?
What do I do?

What happens?/Comments

1.

Click the Users tab.

2.

Select Test Group.

Make sure you select it so it changes to
blue (rather than grey).

3.

Click Add User.

The New User list appears:

The listed names have already been
entered in the database as Contacts.
Use the Contacts form (under Admin)
enter a new person on this list.

4.

Select Liza Montgomery of Allstate
Steel.

5.

Click OK.

6.

In the Password field, type fred.

7.

Click Save.

8.

Click Yes.

9.

In the Access column, check all four
boxes.

10. Click Save.

11. Click Yes.
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Liza’s name appears in the Name field.

A message asks if you wish to Commit
changes?

Liza will be working in all these
projects.
A message asks if you wish to Commit
changes?

Lesson 2: Security

12.

What do I do?

What happens?/Comments

Click Close.

Security Manager closes.
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Task A.4 How Do I View My Changes?
Now you can log out of your database (as Admin) and log back in as Liza to view your
changes in the reports Liza can generate.

What do I do?

What happens?/Comments

1.

On the Prolog Manager File menu,
click Open Database.

A message informs you this action will
close the current database.

2.

Click Yes.

The Log On dialog appears.

3.

In the User Name field, select Liza
Montgomery.

If Liza’s name does not appear in the
list, click the Refresh
button and
drop down the list a second time.

4.

In the Password field, type fred.

5.

Click OK.

6.

Select Downtown Medical Center.

7.

Click OK.

8.

On the Switchboard, click Reports,
and on the submenu, point to
Purchase.

Addendum Setup does not appear on
the second submenu.

9.

On the second submenu, click Bid
Packages.

The Report Manager opens to Bid
Packages, and the Bid Package
Summary reports are not visible.

The Select Project list appears.

Addendum Setup appears in the tree
beneath Purchase without a + sign. If
you click on the folder icon, no report
names appear.
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B. Restricting Access to Reports Data
You can also restrict access to specific data within your database. You can specify data
groups which cannot be viewed by users in specific user groups. If you restrict access to a
datagroup and a user runs a report which includes data from that datagroup, the data does
not appear in the report.
In this task you will restrict the TestGroup members’ access to contract data and then view
the results when a member of this group runs a contract report.

Task B.1

How Do I View Default Report Access?

What do I do?
1.

If you have not already done so, log
in to Downtown Medical Center as
Admin.

2.

On the Switchboard, click Reports,
and on the menu click Cost Control
and on the submenu click Contracts.

3.

Select Contracts [Detailed Scopes
of Work, Grouped by Contract
Number].

What happens?/Comments

The Report Manager tree appears
opened to the Contract group:
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What do I do?

What happens?/Comments

4.

Click Run.

The report appears with detailed
contract information:

5.

On the Preview window, click Close.

6.

On the Report Manager, click Close.
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Task B.2

How Do I Restrict Data Access in Report Manager?

What do I do?

What happens?/Comments

1.

On the Tools menu, click Security
and on the submenu, click Security
Manager.

The Security Manager appears:

2.

On the Users tab, select TestGroup.

This is the user group you created.

3.

Click the Data Group Permissions
tab.

The User Group field on the page
displays TestGroup.

4.

In the Data Group list, select
Contracts.

5.

Click on the green arrow next to
Contacts.

A message informs you that changing
the permission status of a data group
sets the same permission status for all
fiels in that data group.

6.

Click Yes.

The green arrow changes to a pair of
eyeglasses, indicating the group users
can view data but not change it.

7.

Click on the eyeglasses next to
Contacts.

A message informs you that changing
the permission status of a data group
sets the same permission status for all
field in that data group.

8.

Click Yes.

The eyeglasses change to a red No
symbol, indicating users in that
group can not view data in this
datagroup.

9.

Click Save.

A message asks you to confirm your
changes.
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What do I do?

What happens?/Comments

10. Click Yes.
11. Click Close.
12. In the Prolog Manager File menu,
click Close Database.
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You will log out as Admin and re-log in
as Liza Montgomery, the member you
created for the TestGroup group.
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Task B.3

How Do I View the Effects of My Changes?

What do I do?

What happens?/Comments

1.

In the Prolog Manager File menu,
click Prolog Sample Database Downtown Medical Center.

The Log On dialog appears.

2.

In the User Name field, select Liza
Montgomery.

3.

In the Password field, type fred.

4.

Click OK.

5.

On the Switchboard, click Reports,
and on the menu click Cost Control
and on the submenu click Contracts.

6.

Select Contracts [Detailed Scopes
of Work, Grouped by Contract
Number].

7.

Click Run.

8.

On the Preview window, click Close.

9.

On the Report Manager, click Close.

The Report Manager tree appears as
before, opened to the Contract group.

The report appears with no data:
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L e s s o n

3

INTRO TO CRYSTAL REPORTS
Introduction to Crystal Reports

Lesson Overview
This lesson provides a first look at using Crystal Reports to
modify Prolog Manager reports. It includes the following tasks
and explanations:
A. Crystal Reports Features
B. Deleting Columns
C. Adding Columns to a Report
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A. Crystal Reports Features
Prolog Manager’s Report Manager retrieves records from the database to create reports. It
also can be used to make some changes in the report’s formatting and display.
Seagate Crystal Reports, however, is an advanced report customization tool. Using Crystal
Reports you can add or remove fields from a report and redesign the entire report layout.
You can work in a “virtual report” interface to modify a report without ever viewing actual
data. You can also customize reports easily, without revealing potentially confidential data
or tying up your computer or network to gather the data.
Prolog Manager has been designed to work with Crystal Reports easily. You can enter the
Crystal environment from within Prolog Manager. Once you create a report in Crystal
Reports, you can use it with all Meridian Project Pack applications.
Crystal Reports allows you to:
•

Specify how to sort columns of data, how to group related information together and
whether to display or hide each data group at printing

•

Design formulas to control formatting or to calculate values (such as column totals),
using the data contained in the report’s other fields

•

Insert a company logo or other graphic

•

Format text, use background color and border styles

•

Format report in sections, so as to call attention to selected data

•

Create running total fields which total running amounts from column data

•

Insert subreports–reports within reports–to combine unrelated data in a single report
and display that data independently or linked with other fields

The Crystal Environment
The Crystal Reports Designer environment allows you to modify Prolog Manager reports
to your specifications. Each section of the Crystal environment shows up as a
corresponding section of a Prolog Report. The following illustration depicts this
correspondence:
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Page Headers
2nd page on

Group Headers #1

Column Headers

Group Headers #2

Details Section Page Footer

Reports Footer

Report Header
1st Page only
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Many of these elements on the report itself and the Crystal environment can also be set from
Options tab of Prolog Manager’s Report Manager:

The following table relates the fields in Prolog Manager to the rows in Crystal reports and
their effects on reports. The Words in My HotList Report column refers to the report shown
on the previous page.
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Field on Options tab of
Report Manager

Row in Crystal Reports
environment

Words in My HotList
Report

Project Name

Group Header #1a

Downtown Medical Center
Project # 99-2045
Acme Construction

Project Address

Group Header #1b

2100 Pine Street
Santa Monica, CA 90025
Tel No./Fax No.

System Footer

Page Footer c

Prolog Manager
Print date
Database name

User-defined report footer

Page Footer b

My Own HotList

Description

Page Footer a

Our custom HotList based
on type and responsibility

Filter Statement

Report Footer

ResponsibleContact.Displa
yName = etc.
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A Cool Tool:

In the Crystal environment, you can right-click the left-hand column on the
name for a row and from the shortcut menu, click Format Section. A
Section Expert dialog appears which allows a wide range of formatting
options for that section, including page breaks after sections.

Task A.1 How Do I View a Report through Crystal Reports
Designer?
This exercise you will copy a report and then view its setup through the Crystal
environment.

What do I do?

What happens?/Comments

1.

If you have not already done so, log
into Prolog Manager as Admin.

Access to Crystal requires Admin
privileges.

2.

On the Switchboard, click Reports,
and on the submenu click Cost
Control and on the submenu click
Budget Codes.

The Reports tree opens, expanded to
show the groups beneath System:

You cannot edit System reports in
Crystal. You can copy a System report
as a Public report and then edit it.

3.

Select Budget Codes [Actual Cost
Summary Grouped by Group 1 and
Group 3].

4.

Right-click and on the shortcut
menu, click Copy.

5.

In the Reports tree, select Public.
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6.

What do I do?

What happens?/Comments

Right-click and on the shortcut
menu, click Paste.

The name of the report appears in the
Report tree as a Public report,
indicating a copy of the report has been
created in the Public folder.
The copy of the report is an .rpt file
located in the \\Program files\
Meridian\PM6\Programs\User
Reports folder. This file can be edited,
modified or shared with other users.

7.

With the name of the copy of the
report still selected, click the General
tab.

8.

Click Layout....

Crystal Reports Designer opens the
copied .rpt file with the setup
information for the selected report:
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What do I do?

What happens?/Comments
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B. Deleting Columns
Task B.1

How Do I Delete Columns from a Report?

In this task, you will run the report you just copied. Then you will delete a column from it,
adjust the column layout and run the report again.

1.

What do I do?

What happens?/Comments

In the Report Manager, click Run.

The report appears:

The report includes a column for
Uncommitted Costs.

2.
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Close the Report Viewer.
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What do I do?
3.

What happens?/Comments

In the Crystal environment, in the
(shaded black) Group Header #1d
row, click BCPendingCom.

This is the header name for the
reports’s column labeled Pending
Commintments. The tool tip for this
cell reads Ing.BCPendingCommit
(string).

4.

Hold down the CTRL key and click
the cells in the five rows of the
PCPending Com column for the five
rows with entries:
Details
Group Footer #3
Group Footer #2a
Group Footer #1a
Report Footer #a

5.

Press DEL.

The column is erased.
As you can see, the report now has an
empty space between columns. You
will adjust the layout
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What do I do?
6.

Click in the column header for the
column to the left of the empty space
labeled BCUnCommitCosts.

7.

Hold down the CTRL key and click
the cells in the five rows beneath it
the header, the same rows listed in
step 3 above.

8.

Release the CTRL key and drag the
column heading cell to the right to
center it in the empty space.

What happens?/Comments

As you can see, this will center the
column but the columns will not be
balanced. When rearranging columns it
usually takes a “good guess” and a few
trial runs until the right effect appears.
In this exercise you are only centering
one column to take the place of two. In
a real work situation, you may want to
move several columns in a grid to
appear balanced while taking up the
freed space.

9.
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In the Crystal environment, click
Save.
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10.

What do I do?

What happens?/Comments

On the Prolog Manager Report
Manager (with this same Public
report still selected), click Run.

The revised version of the report
appears. Note that the column for
Pending Commitments has been
removed and the column for
Uncommitted Costs straddles the
space:

A Cool Tool:

For precise allignment of a cell, you can right-click the cell and on the
shortcut menu click Object Size and Position.

57

Advanced Reporting with Prolog Manager 6.0

C. Adding Columns to a Report
When you wish to add a column to a Prolog Manager report through Crystal Reports, you
must do all of the following:
1

Copy the existing system report as a public report (in Prolog Manager’s Report
Manager)

2

Create a .ttx file and add information to it about the new column (in Prolog Manager
Report Manager)

3

Associate the new modified .ttx file with the public report (in Crystal Reports Design
view)

4

Rearrange the existing columns (in Crystal Reports Design view)

5

Create, position and format a detail cell for the new column (in Crystal Reports Design
view)

6

Create, position and format column header/formula cell for the new column (in Crystal
Reports Design view)

Important:

For this exercise to work, you must have the 32-bit version of Seagate
Crystal Reports 8.0 installed on your computer.

Task C.1 How Do I Copy a Report?
As you have already seen in previous tasks, you cannot modify a system report. You must
copy it as a public report and then modify the copy.
In this task you will copy and rename an RFI report so that it is available for additional
modification.
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What do I do?

What happens?/Comments

1.

In Prolog Manager’s Switchboard,
click Reports, from the menu click
Doc Control, and from the submenu
click Request for Information.

The Report Manager opens to the RFI
reports.

2.

Select Request for Information
[Summary Log, Grouped by
Company].

3.

Right-click and on the shortcut
menu, click Copy.
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What do I do?

What happens?/Comments

4.

In the Report Manager Reports Tree,
select Public.

5.

Right-click and on the shortcut
menu, click Paste.

6.

In the Report Manager Title field,
rename this report as RFI Summary
(with Importance).

7.

In the Subtitle field, change the entry
to read Grouped by Company.

The [] brackets are added
automatically.

8.

Click Save.

RFI Summary (with Importance)
[Grouped by Company] is selected in
the Reports Tree.

The copied report appears in the
Reports Tree beneath Public.
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Task C.2 How Do I Create a .ttx File?
.ttx files or Field Definition Files are the bridge connecting Seagate Crystal Reports with
Prolog Manager data groups. Existing Prolog Manager reports contain .ttx file information
within their coding, so they do not require separate .ttx files. To add a field to a report, you
must first create a .ttx file from the information in the original report and then add
information about the additional field.

You will add a column which will include the value in the Importance field for each RFI.

1.

In the Reports Tree, select the
Request for Information report you
copied.

2.

Click Field Definition File.

The Edit Report TTX dialog for the
report appears:

The Fields list on the right lists the
fields already included in the .ttx
information for this report. The list on
the left lists all the table names
available for this report.
You will add a field indicating the
RFI’s Importance.

60

3.

In the table name list click on the (+)
sign next to RFI.

The list expands to display the fields in
the table.

4.

Beneath RFI, double-click
Importance.

RFI.Importance appears in the Fields
list.

5.

Click Save As.
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6.

7.

Name the file RFI Summary (with
Importance) and save it in the User
Reports folder.

Click Close.

The file is saved with .71.ttx appended
to the name.
The data group that makes up the report
determines the number that is assigned.
Do not change the .71.ttx part of the
file name or an error may result when
you run the report.
This procedure creates a new .ttx file
out of the .ttx information in the
original file, but it does not associate
that new file to the copy of the report.
The Report Manager returns.
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Task C.3 How Do I Associate a .ttx file?
After you create a .ttx file, you must associate it with the report.

1.

In the Report Manager, click the
General tab.

2.

Click Layout.

Crystal Reports appears in the Design
view.

3.
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In the Crystal Database menu, click
Set Location.

The Set Location dialog appears:
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4.

Click Set Location.

The Data Explorer appears:

5.

Click the (+) next to More Data
Sources.

6.

Click the (+) next to Active Data.

7.

Click the (+) next to Active Data
(Field Definitions Only).

8.

Click Browse.

9.

Open C:\Program Files\Meridian\
Prolog Manager 6\Program\
User Report\RFI Summary (with
Importance).71.ttx.

The tree expands.

The Select Data Source dialog
appears:

This is the file you created. You can
associate the report to a .ttx file located
anywhere.
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10. On the Select Data Source dialog,
click OK.

The Data Explorer returns with the file
you created appearing and selected in
the tree:

11. Click Set.

The Set Location dialog returns
showing RFI Summary (with
Importantce).71.ttx in the Table field:

12. Click Done.

A message informs you that the file
“Requests for Information” has
changed and asks if you want to
proceed to fix up the report.

13. Click Yes.
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The new .ttx file is now associated
with your copy of the report.
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A Cool Tool:

Now that the .ttx file has been associated with the report, you can add
additional fields to the report by editing the .ttx and no re-associating is
necessary. Open the report in Reports Manager, click File Definition File,
add the fields and save. Then in Crystal Reports’s Database menu, click
Verify Database. A confirmation message asks if you want to fix up the
report, click Yes.
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Task C.4 How Do I Reposition Columns in a Report?
Before you can add a column to a report, you must create a space for that column in the
Crystal Reports Designer.
A Cool Tool:

You can set options in Crystal Reports that determine how the application
display and behaves. To access these options, on the File menu, click
Preferences. The rest of this Task assumes the following settings:
Snap to Grid has been checked
Grid Size is set to .01 inch
Show Rulers in Design has been checked
Show Guidelines in Design has been checked
If this is your first time using Crystal Reports, check that these options
have been set before proceeding.

What do I do?
1.

What happens?/Comments

In the Crystal Reports toolbar, set the
Zoom Control to 200%.

This setting allow for more accurate
placement of elements in the
workspace.

2.

Click on the column header (black)
cell for the @lng.DateCreated
column.

The full name of the column does not
display, since it is longer than the
column width allows. @Ing.DateC
displays. The full title appears in a
ToolTip.
When you click on a cell, it becomes
bordered in black and white stripes:
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3.

What do I do?

What happens?/Comments

Drag the right hand edge of the
striped cell border to the left and drop
so as to reduce the cell width from
(approximately) .62” (5/8”) to .5”.

When your cursor is properly
positioned over the white cell border,
the cursor becomes a small two-headed
arrow and a dark vertical line shows
shows the edge of the cell across the
gird:

Note: Use the rulers at the top of the
design area to set the width
properly.

4.

In that same column, click on the cell
in the Details row (two rows down).
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5.

What do I do?

What happens?/Comments

Drag the right hand edge of the
striped cell border to the left and drop
so as to reduce the cell width to
match the cell header at .5”.

When your cursor is properly
positioned over the white cell border,
the cursor becomes a small two-headed
arrow and a dark vertical line shows
shows the edge of the cell across the
gird:.

Moving to the next column to the right,
the column header for @lng.DateReq’d
is already set at .5”.

6.
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In the next column to the right, click
on the Details cell for this row,
RFI~DateRequired.
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7.

What do I do?

What happens?/Comments

Drag the right hand edge of the
striped cell border to the left and drop
so as to reduce the cell width to
match the cell header at .5”.

Now that you have reduced this
column to .5”, you want to slide it to
the left to recreate space for the new
column you will add.
The light dashed lines on either end of
the column are guidelines.

The small red x’s on the left hand edge
of the cells touching the guidelines
indicate that the cell is “stuck” to
guideline. Dragging the arrow will
drag the cells.

8.

Drag the arrow at the top of the left
side of this column and drop it so that
it touches the left edge of the column
on its left (Date Created).

You now have two .5” columns instead
of .62” columns, and the extra space is
to the left of the Date Required
column.
Move now to the next column to the
right, Date Responded.

9.

Reduce the width of the
@lng.DateRep cell to .5”

10.

Reduce the width of the
@RFI~DateResp cell to .5”.
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What do I do?
11. Drag the arrow at the top left of this
column and drop it on the left edge of
the Date Required column.

What happens?/Comments
The next column to the right, Cost
Impact is already set at .5”, but you
must drag it to the left.

12. Drag the arrow at the top left of the
Cost Impact column and drop it on
the left edge of the Date Responded
column.

13. Reduce the width of the @lng.Amt
cell to .5”.

14. Reduce the width of the RFI~Amount
cell to .5”

You should now have about .5” of
empty space between these two cells in
the Amount column and the column to
its right, Schedule Impact.
Now you have realigned the columned
and created a space for the column you
wish to add:

15. Click Save.
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A Cool Tool:

Occasionally, after you click somewhere in Crystal Reports, the screen
does not refresh. Crystal Reports does not have a Refresh command on any
of its menus. To make your screen refresh, minimize Crystal Reports and
then maximize it again.

A Cool Tool:

When trying to select a column header cell in Crystal Reports, you may
“just miss” the column and instead select the entire black column head
region. To try again to select the cell, first click on a plain white area of the
workspace to “remove” the selection of the whole black area. Then try
again.
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Task C.5 How Do I Set Up Column Detail Information?
Now that you have created a space, you will create a table header cell and a detail cell for
that column. The details cell specifies which field in the database appears in that column
for the record that matches the report description. The table column includes the formula
that is applied to the field named in the details cell. In this task you will create, format and
position the details cell.

1.

What do I do?

What happens?/Comments

In Crystal Reports, in the Insert
menu, click Database Field.

The Field Explorer appears with
Database Fields selected:

You want to select a field in the
database which will be inserted into the
report. That field can be inserted “as
is,” or acted upon by a formula which
will be specified in the column header
field.

2.

Click the (+) next to Requests for
Information.

The fields in the report expand beneath
Requests for Information.

3.

Select RFI~Importance.

This is the field you added to the .ttx
file when you created it.

4.

Drag RFI~Importance and drop in an
unused white area of Crystal Reports.

The field appears in Crystal Reports.

By placing the field first in an unused
area, you can format it before dropping
in where it belongs.
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What do I do?

What happens?/Comments

5.

Click on the field and reduce its
width to .5”

The full name of the field will not be
visible when you reduce it.

6.

Right-click on the field and on the
shortcut menu, click Format Field.

The Format Editor appears:

7.

Click the Font tab.

You want to format this cell to match
the other cells in the Details row.

8.

In the Font field, select Arial
(Western).

9.

In the Size field, select 8.

10. Click OK.
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Now the cell is ready to drag and drop
to where it belongs, but first you will
create a guideline to make it easier for
you to line it up accurately.
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What do I do?
11.

What happens?/Comments

Click on the ruler on the left-hand
edge of the Details row to create a
guideline to which appears to run
through the red x’s at the top of each
cell.

When you click on the left-hand ruler,
a new guideline appears with an arrow
at its end. If you hit it right, the
guideline appears to run through the
red x’s at the top of each cell.

If you miss, drag the arrow at the end of
the guideline up or down to adjust it:
Now you can drag the cell you created
to the Details row; but first you will
insert a similar guideline in the (black)
column header row.

12.

Click on the ruler at the top of the
Group Header #1d row to set a
guideline that goes through the red
x’s in the (black) column header row.

You will use this guideline when you
place the formula cell in this row.
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What do I do?

What happens?/Comments

13. Click the cell you created, drag it and
drop on the space you created
between RFI~Amount and
sys.IsSchedImpact

If you created the guideline accurately
and drop the cell close to it, the cell will
grab onto the guideline and be lined up
properly.
Now you will create the table header
cell.

14. Click Save.

Now you have created and placed the
details field and you can now create
and place the column header/formula
field.
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Task C.6 How Do I Set Up Column Header Formula Information?
The table column header (or title) includes the formula that is applied to the field named in
the details cell. In this task you will create, format and position the table header or formula
cell.

1.

In the Field Explorer, select Formula
Fields.

Formula fields are fields in which a
formula is applied to the value in a field
in the database and the calculated value
is inserted into the report. When you
create a formula field, you specify the
formula.

2.

Right-click and in the shortcut menu,
click New.

The Formula Name dialog appears:

3.

Type lng.Importance.

Formula fields for column headers
begin with lng., followed by the
column header text. This column will
be titled Importance. An @ sign will
appear before this name in the Crystal
Reports Design environment.
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4.

Click OK.

The Formula Editor appears, set to
create the formula for the
@lng.Importance field:

5.

In the editing area type:

This is the formula describing what
happens when the report generates.

//Passed at runtime from language
database.
"Importance"

// indicates that the text that follows is
a comment; it describes in English
which the body of the formula directs
Crystal Reports to do. It this case it
indicates, “When the reports run, get
the value from the language database
and insert it.”
“Importance” mean “Find the value in
the Importance field and insert it.”
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6.

In the Formula Editor, click Save
and Close.

7.

In the Field Explorer, select
lng.Importance.
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8.

Drag lng.Importance and drop on a
blank (white) area of Crystal
Reports.

The @lng.Importance cell appears:

You want to format this cell before you
position it in the grid. You could
change the font name, size and color, as
you did in step 6–10 of Task C.5 “How
Do I Set Up Column Detail
Information?” on page 71. However,
the follow three steps are a shortcut to
copy all formatting from one cell to
another.

9.

With @lng.Importance still selected,
press CTRL+right-click on
@lng.Amt.

You could right-click on any (black)
column header cell as they are all
formatted identically.

10.

On the shortcut menu, click Format
Objects.

The Format Editor appears, displaying
the formatting information for
@lng.Amt.

11.

Click OK.

All of the formatting information for
@lng.Amt is applied to
@lng.Importance. Since this format
includes white text, the cell appears
empty.

12.

Click the @lng.Importance cell and
reduce its width to .5”.
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13.

Click the @lng.Importance cell and
drag it and drop on the empty space
between @lng.Amn and
@sys.Schedlmpact.

The cell will stick to the guideline you
created earlier.

14. Click Save.

A Cool Tool:
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If you do not know the Crystal Reports formula syntax for the column you
wish to define, you can open the Formula Editor for a column header than
acts similarly, copy the text, and paste it into the Formula Editor for the
new field, and then edit it. For example, in this procedure if you didn’t
know the text needed for step 5, you could open the Formula Editor for
the @lng.Amt column header which also selects the designated field
(“Amt” in this case) from the record in the database and enter it, and then
edit “Amt” into “Importance”.
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Task C.7 How Do I View My Results?
Now you can return to Prolog Manager’s Reports Manager and run your report and view
the effects of your changes.

What do I do?
1.

In Prolog Manager, on the
Switchboard, click Reports and on
the menu, click Public.

2.

Select RFI Summary (with
Importance) [Grouped by
Company].

3.

Click Run.

What happens?/Comments

The revised report appears with the
new name and including an Importance
column:
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4

CREATING NEW REPORTS
Creating New Reports

Lesson Overview
In this lesson, you will create a new report using Prolog Manager
and Crystal Reports. You will also install a report on your
computer.
A. Creating a New Report
B. Installing a New Report
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A. Creating a New Report
Now that you have removed and added columns to a Prolog Manager report using Crystal
Reports, you have the tools to create a new report from scratch. This process involves the
following tasks:
1

Create a .ttx file including the fields to appear in this report (in Prolog Manager’s
Report Manager)

2

Create a new report from a template (in Prolog Manager’s Report Manager)

3

Associate the .ttx file to the report (in Crystal Reports Design view)

4

Set up the Group Name in the report (in Crystal Reports Design view)

5

Add and format details to the body of the report (in Crystal Reports Design view)

6

Add and format column headers and set their formulas (in Crystal Reports Design
view)

7

Name the report (in Prolog Manager’s Report Manager)

You will create a report which will list each company Contact person, sorted by company,
and including their Display Name, e-mail address and telephone number.

Task A.1 How Do I Create a .ttx File from Scratch?
What do I do?
1.

What happens?/Comments

In Prolog Manager, click Report
Manager.

The Report Manager opens.

2.

Click Field Definition File.

The Edit Report TTX dialog appears.

82

Lesson 4 Creating New Reports

What do I do?
3.

What happens?/Comments

Click the Create New tab.

On this dialog you specify the fields
you wish to appear in your report.

4.

In the Data Group list, select Project
Contact List.

The tables in that data group appear
beneath it.

5.

Click the (+) next to Project.

The fields in the table appear beneath
it.

6.

Double-click the following fields:

Double-clicking a field moves it to the
right-hand window and includes it in
the .ttx file.

Address
Company Name
Job Fax
Job Telephone
Project ID
Project Name
Project Number

These are common fields in every
Prolog Manager report. Strictly
speaking they are not “required”, but
the default report templates include
them.

7.

In the list of tables, click the (+) next
to Logos.

The one field in the table expands
beneath it.

8.

Double-click Logo.

The default templates place the logo on
each report.

9.

In the list of tables, click the (+) next
to Company.

The rest of the fields to be selected are
the unique set for this report.

10.

Double-click Company Name.

11.

In the list of tables, click the (+) next
to Contacts.
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What do I do?

What happens?/Comments

12. Double-click the following fields:
Display Name
E-mail
Telephone

13. Click Save.

The Save As dialog appears.

14. In the File Name field of the Save As
dialog, type Contacts List.

15. Click Save.

The file is saved as Contacts
List.112.ttx.
Do not change the 112.ttx part of this
file name.

16. On the Edit Report TTX dialog, click
Close.
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The Report Manager returns.
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Task A.2 How Do I Create a New Report from a Template?
What do I do?
1.

What happens?/Comments

On the Report Manager, click Add
Report.
The New Report dialog appears:

2.

On the Create from Template tab,
select Template(Portrait).rpt.

You will modify this template to create
your report.
The “each page” templates start each
company’s data on a separate page.

3.

Click OK.

4.

Click the General tab.

New Report [New Subtitle] appears in
the Public folder of the Report
Manager.
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What do I do?
5.

What happens?/Comments

Click Layout.

Crystal Reports appears with the
template open in the Design mode:

Strictly speaking, the report is not
created until you save it, but we won’t
save it until we associate the .ttx file
and set the alias.
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Task A.3 How Do I Associate the .ttx File to the New Report?
What do I do?

What happens?/Comments

1.

In Crystal Reports, on the Database
menu, click Set Location.

The Set Location dialog opens,
showing the report is associated to
Generic.ttx:

2.

Click Set Location.

The Data Explorer appears:

3.

Click the (+) sign next to More Data
Sources.

Available data sources expand beneath.

4.

Click the (+) sign next to Active
Data.
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What do I do?

What happens?/Comments

5.

Click the (+) sign next to Active
Data (Field Definitions Only).

The Select Data Source dialog
appears:

6.

Click Browse.

The Select Data Definition File dialog
appears.

7.

In the File Name field, select
C:\Program Files\Meridian\
Prolog Manager 6\Program\
User Reports\Contact List.112.ttx.

8.

Click Open.

The Select Data Source dialog returns.

9.

Click OK.

The Data Explorer returns with
Contacts List.112.ttx selected.

10. Click Set.

The Set Location dialog returns.

11. Click Done.

A Verify Database message informs
you that the database file “Generic” has
changed and asks if you want to fix up
the report.

12. Click Yes.

Now you will change the alias for this
report.
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What do I do?

What happens?/Comments

13.

In the Database menu, click Set
Alias...

The Set Alias dialog appears:

14.

Click Set Alias.

The Alias Name -dialog appears:

15.

Replace Generic with Contact List.

16.

Click OK.

17.

Click Done.

The Set Alias dialog returns.
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Task A.4 How Do I Set Up a Group Name in a New Report?
Prolog Manager reports display their information subdivided by groups. The primary group
for all Prolog Manager reports is project. In this report, contacts display divided by project.
You want them to be subdivided by company, so you will set the Company Name field in
the Company table as the next group, and you will format that information in Crystal to
appear as the information will appear in the report.

What do I do?

What happens?/Comments

1.

In Crystal Reports Insert menu, click
Group.

The Insert Group dialog appears:

2.

Select Company~Name.

3.

Click OK.

A new row is added to the Crystal
Reports Design view called Group #2
Name:

Next you will format this field.
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What do I do?

What happens?/Comments

4.

Right-click Group #2 Name and on
the shortcut menu, click Format
Field...

The Format Editor appears:

5.

Click the Font tab.

6.

In the Font field, select Arial
(Western).

7.

In the Size field, select 9.

8.

Click OK.
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Task A.5 How Do I Insert Field Data Columns into a Report?
Beneath each company, you want to display the contact’s name, e-mail address and
telephone. Each contact is a record, and each of these bits of data is a field in the database.
Each contact person will appear as rows and the data fields appear as column.
In this task you will specify which fields will be column. You will format the column
information in Crystal to appear as you want that information to appear in the report.

What do I do?

What happens?/Comments

1.

On the Insert menu, click Database
Field.

The Field Explorer appears:

2.

Click the (+) next to Contact Lists.

The list of fields appears.

3.

Drag Contacts~DisplayName from
the Field Explorer and drop in
Crystal Reports Design environment
on the left-hand side of the Details
row.

Two new cells labeled
Contacts~DisplayName appear in
Crystal Reports:

The cell in the Page Header c row
creates a column header for the
Contacts~DisplayName field. You
will delete this cell and create your own
column header for this column.
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What do I do?

What happens?/Comments

4.

In the Page Header c row, select
Contacts~DisplayName.

5.

Press DEL.

6.

In the Details row, select
Contacts~DisplayName.

7.

Reduce the width of this cell to 1”.

8.

In the Field Explorer, drag
Contacts~EMail and drop in the
Details row, to the right of
Contacts~DisplayName.

9.

Repeat steps 4–7 for the
Contacts~EMail cell.

10.

In the Field Explorer, drag
Contacts~Telephone and drop in the
Details row, to the right of
Contacts~EMail.

11.

Repeat steps 4–7. for the
Contacts~Telephone cell.

12.

Select the Contacts~DisplayName
cell.

The Format Editor appears.

13.

Click the Contacts~EMail cell.

Both cells are now selected.

14.

CTRL+right-click the

The column header is deleted.

Contacts~Telephone cell.

15.

On the shortcut menu, click Format
Objects.

16.

Click the Font tab.

17.

In the Font field, select Arial
(Western).

The Format Editor appears.
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What do I do?

What happens?/Comments

18. In the Size field, select 9.

Make sure the Style field set to Regular
and the Color field is set to Black.

19. Click OK.

The formatting of you specified is
applied to all three cells:

Alternately, you can right-click each
cell and set its formatting manually.
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Task A.6 How Do I Set Column Headers/Formulae?
Column headers cells provide the formatting for the column headers in the report. They also
contain within them the formula which is applied to the data in the rows beneath them. As
the report template uses a black background with white text for the column headers, you
will format them that way. Since this report presents the values in the fields without
performing a mathematical operation on them, the formulae here are very simple.

What do I do?

What happens?/Comments

1.

In the Insert menu, click Formula
Field.

In the Field Explorer, the list of
Formula Fields expands:

2.

On the Field Explorer, click New.

The Formula Name dialog appears:

3.

In the Name field, type:
lng.DisplayName.

Formula fields begin with lng..

4.

Click OK.

The Formula Editor opens to
@lng.DisplayName:
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What do I do?

What happens?/Comments

5.

On the first line of the editing area,
type: //Passed at runtime from
language database.

The // means this statement is a
comment. It has no significance except
to explain to the next person who looks
at it, what this formula is doing. It
means that when the report run, Crystal
Reports extracts the value from a field
in the database.

6.

In the second line, type: “Contact
Name”.

Include the quotation marks. Contact
Name is the field whose value is
extracted from the database. The
quotation marks mean just display this
value.

7.

On the Formula Editor, click Save.

8.

On the Formula Editor, click New.

9.

Repeat steps 3-8 with the following
changes:
In step 3, in the Name field, type:
lng.EMail.

10. In step 6, in the second line of the

Include the quotes.

Formula Editor, type “EMail”.

11. Repeat steps 3-6 once again with the
following changes:
In step 3, in the Name field, type:
lng.Telephone.

12. In step 6, in the second line of the
Formula Editor, type “Telephone”.
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Include the quotes.
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What do I do?
13.

What happens?/Comments

Click Save and Close.

The Formula Editor closes and the new
Formula Fields you created appear in
the Field Explorer list.
Now you will create the format and
position these Formula Fields as the
column headers.

14.

Drag the lower border of the Group
Header #1c row (immediately above
the black row) and drop when it is a
bit wider than the black row.

You will use this space to temporarily
park cells for the Formula Fields you
just created.

15.

Drag Ing.DisplayName from the
Field Explorer and drop on the lefthand side of row Group Header #1c.

16.

Drag lng.Email from the Field
Explorer and drop above and in line
with Contacts~Email.
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What do I do?

What happens?/Comments

17. Drag lng.Telephone from the Field
Explorer and drop above and in line
with Contacts~Telephone.

Now you have placed each Formula
Field and you can edit and format them.

18. Right-click @lng.DisplayName and

The Format Editor appears.

from the shortcut menu, click Format
Field.

19. Click the Font tab.
20. In the Font field, select Arial
(Western).

21. In the Style field, select Bold.
22. In the Size field, click 10.
23. In the Color field, click White.
24. Click the Formula button next to
Color.

The Format Formula Editor for the
Font Color appears.

25. In the editing space, type:
//This is the conditional formatting
provided. It is passed at runtime.
//If the flag passed is 1=Enhanced
Report, else 0=General Report
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These are comments to describe what
the subsequent lines will do.
Each of these are one line of text in the
editing window. If you break one of
them into two lines, you must put // at
the beginning of each line.
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26.

What do I do?

What happens?/Comments

Type:

This coding that ensures the column
head print white text on their black
background and black text on any other
color background.

If {@sys.Format}=”1” Then
White
Else
Black

27.

Click Save and Close.

The Format Editor returns.

28.

Click OK.

The Format Editor closes. The cell in
Crystal Reports appears blank;
however, it only appears that way as its
text is white.

29.

Click the @lng.Email cell.

30.

CTRL+right-click the

The Format Editor appears.

@lng.ContactName cell and from
the shortcut menu, click Format
Objects...

31.

Click OK.

32.

Click the @lng.Telephone cell.

33.

CTRL+right-click the

The formatting (including the formula)
are copied from the DisplayName cell
to the Email cell. It appears to be
empty.

The Format Editor appears.

@lng.ContactName cell and from
the shortcut menu, click Format
Objects...

34.

Click OK.

The formatting (including the formula)
are copied from the DisplayName cell
to the Email cell. It appears to be
empty.
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What do I do?
35. Drag each of the three “white” cells
down one row and drop in the Group
Header #1d row.

What happens?/Comments
The cells now appears as white text in
a black background:

36. Drag the lower border of the Group
Header #1c row upward and drop
when the row returns to its original
narrow size.

37. Click Save.

You can close Crystal Reports now,
buy you might want to keep it open
until you run the report and verify that
it is correct.
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Task A.7 How Do I Rename the Report?
The final segment of the report creation process is returning to Prolog Manager to name and
run the report. Up to this point you have been modifying the .rpt file which generates the
new report. Now you must assign that file to a report name.

What do I do?

What happens?/Comments

1.

Return to the Prolog Manager’s
Report Manager.

.

2.

In the Reports Tree select the Public
folder.

A message asks whether you want to
save recent changes.

3.

Click No

4.

Click Add Report.

The New Report dialog appears:

5.

Click the Use existing User Reports
tab.

The User Reports list appears;

6.

Select Contact List.rpt.

This is the file you have been creating.

7.

Click OK.

The New Report dialog closes and the
Report Manager appears with New
Report [New Subtitle] selected:
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What do I do?
8.

Change the Title field to Contact
List.

9.

Change the Subtitle field to Grpt by
Company.

What happens?/Comments

10. Click Save.
11. Click Run.

The Report appears:

When you close the report, its name
remains in the Public folder of the
Reports Tree for with continued
availability.
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B. Installing a New Report
After you have created a new report, other staff people on your network have the ability to
run that report on their computers. However, if you wish to allow people who are not on
your network to run this report, you can copy the report to the other computers and then
install it in Report Manager. You can send it to the other computer(s) by email or by
copying on a floppy drive. (Reports created in Crystal Reports or other installations of
Prolog Manager are referred to as “existing reports.”)
Note: This section generally applies to stand-alone installations of Prolog Manager. If
you are running Prolog Manager on a network server, once you’ve added the
report to the server installation, everyone accessing that server can use the new
report.

Task B.1

How Do I Install an Existing Report to Another
Computer?

This task pretends that the report you just created was created by someone else, and now
you will install it to your computer.You receive the existing report Contact List.rpt
attached to an e-mail or on a disk.

What do I do?

What happens?/Comments

1.

Copy the existing report to the folder
C:\Program Files\Meridian\
Prolog Manager 6\User Reports.

This file is already in that folder from
the previous task.

2.

In Prolog Manager, click Reports
Manager.

3.

In the Reports Tree, select the Public
folder.

You could also select Secure or a
subfolder beneath either one.

4.

Click Add Report.

The New Report dialog appears:
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What do I do?

What happens?/Comments

5.

Click the Use existing User Reports
tab.

A list of all the reports in the User
Reports folder appears.

6.

Select Contact List.rpt.

7.

Click OK.

8.

Select New Report [New Subtitle].

9.

In the Title field, replace New Report
with Contact List 2.

The New Report dialog closes, and
New Report appears in the Report
Manager Reports Tree:

10. In the Subtitle Field, replace New
Subtitle with Grouped by Co.

11. Click the General tab.
12. In the Description field, type
Existing Report Copy.

13. Click Save.
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Now you can run this copy of the
report.
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CREATING SUBREPORTS
Creating Subreports

Lesson Overview
In this lesson, you will create a new subreport using Prolog
Manager and Crystal Reports.
A. Creating a Subreport
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A. Creating a Subreport
In a Prolog Manager/Crystal report, either all of the fields that display must reside in the
same datagroup or else you must create a subreport. A subreport allows you to include
fields in a report from outside the datagroup, provided you can identify another field which
resides in the report’s datagroup and which is also in a common datagroup with the field
you wish to add.
The process of creating a subreport is similar to creating a regular report. It can have the
same characteristics of the main report with similar record selection criteria.
However, subreports differ from regular reports in that a subreport:
•

Can be inserted as an object into a primary report

•

Can be placed in any report section and the entire subreport will print in that section

•

Can be saved as a primary report

•

Cannot stand on its own unless saved as a primary report)

•

Cannot contain another subreport

In this task you will add a field to a report by creating a subreport. You will start with the
Submittal Packages Summary, Grouped by Package Number with Register Items. The
field you want to add to this report is the description of the Submittal Type. The Submittal
Type (LU) table is not included in the Submittal Packages data group. The Submittal Type
(LU) table contains an ID and a description. The ID is part of the Submittal Register record.
So, you will use the Submittal Type ID to link the Submittal Register description to the
Submittal Packages report.
This process contains the following elements:
1. Copy the original report and create a new .ttx file to link to a new subreport
2. Modify the original report
3. Create the .ttx for the new subreport
4. Create the new subreport
5. Link the modified original report and the new subreport
6. Modify the subreport
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Task A.1 How Do I Setup My Database for this Task?
The sample database requires a bit of data added to it that will appear in the subreport you
will create.

What do I do?

What happens?/Comments

1.

On the Switchboard, click Doc
Control and on the submenu, click
Submittal Register.

The form appears:

2.

Click Lookup.

The Submittal Register pick list
appears.

3.

Double-click 0126 Plan Help.

The record populates the form.

4.

In the Type field, type Test Type.

A message asks if you want to set up
this lookup type.

5.

Click Yes.

The Lookup Group Maintenance
dialog appears with Test Type in the
Type column.

6.

In the Type ID column, type TT.

7.

Type OK.

8.

Click Save.

9.

Click Close.

Test Type appears in the Type field.
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Task A.2 How Do Create a .ttx File to Link to a Subreport?
What do I do?
1.

Open the Report Manager to the
Submittal Packages Summary,
Grouped by Package Number with
Register Items report.

2.

Copy the report to the Public folder.

What happens?/Comments

Follow the procedure in “How Do I
Copy a Report?” on page 58.
The newly created report is selected.

3.

Click Field Definition File.

4.

Click the + next to Submittal
Register.

5.

Double-click Type ID.

Submittal Register.Type ID is copied
to the Fields list.

6.

Move Submittal Register.Type ID
down just below Submittal
Register.Description.

This field is the link for the subreport.

Click Save As and name the new .ttx
as Submittal Package with
Subreport.ttx,

The file is saved as Submittal Package
with Subreport.65.ttx.

7.
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The Edit Report TTX dialog appears:

The order of fields in the .ttx file does
not matter, but placing them in the
order they appear is helpful for
troubleshooting.

Lesson 5 Creating Subreports

What do I do?
8.

What happens?/Comments

Close the Edit Report TTX dialog.
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Task A.3 How Do Modify My Original Report for a Subreport??
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What do I do?

What happens?/Comments

1.

On the General tab of the Report
Manager, click Layout...

The Crystal environment appears:

2.

Delete the Rec’d On and the
Returned columns.

Follow the procedure in “How Do I
Delete Columns from a Report?” on
page 54.

3.

On the Database menu of Crystal
Reports, click Set Location.

The Set Location dialog appears:

4.

Click Set Location.

5.

Click the + next to More Data
Sources.

6.

Click the + next to Active Data.
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What do I do?

What happens?/Comments

7.

Click the + next to Active Data (Field
Definitions Only.

The Select Data Source dialog
appears:

8.

Click Browse.

9.

Point to the Submittal Package with
Subreport.65.ttx you created and
click Open.

The Select Data Source dialog returns.

10.

Click OK.

The Data Explorer returns.

11.

Click Set.

The Set Location dialog returns.

12.

Click Done.

A message asks if you want to fix up
the report.

13.

Click Yes.

14.

In File menu of Crystal Reports,
click Save. .

You have modified the original report
to accept the subreport.
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What do I do?
15. In Prolog Manager’s Report
Manager, change the subtitle of the
report to with Type Description.

16. Click Save.
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What happens?/Comments

Lesson 5 Creating Subreports

Task A.4 How Do I Create a .ttx File for the Subreport?
What do I do?
1.

In Report Manager, select Submittal
Packages [with Type Description].

2.

Click Field Definition File.

3.

Click the Create New tab.

4.

In the Data Group list, click
Submittal Register.

5.

Click the + sign next to Submittal
Register Type (LU).

6.

Double-click Type and Type ID.

7.

Click Save as and name the file
Submittal register type.

8.

Click Close.

What happens?/Comments

The file is name Submittal register
type.60.ttx.
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Task A.5 How Do I Create a Subreport?
Creating a subreport involves several components. FI

What do I do?

What happens?/Comments

1.

In the Reports Manager, on the
General tab of the Submittal
Packages [with Type Description]
report, click Layout....

The Crystal Reports environment
opens.

2.

On the Insert menu, click Subreport.

The Insert Subreport dialog appears:

Create a subreport is already checked.
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3.

In the Report Name field, type
Register Type Subreport.

4.

Click Report Expert.

The Report Expert dialog appears:

Lesson 5 Creating Subreports

What do I do?

What happens?/Comments

5.

Click Database.

The Data Explorer dialog appears:

6.

Click the + next to More Data
Sources.

7.

Click the + next to Active Data.

8.

Click the + next to Active Data (Field
Definitions Only.

9.

Double-click Make a New
Connection.

10.

Click Browse.

The Select Data Source dialog
appears:
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What do I do?

What happens?/Comments

11. Select the Submittal Register
Type.60.ttx you created.

12. Click Open.

The file appears in the Select Data
Source dialog.

13. Click OK.

The file now appears in the Data
Explorer tree:

14. Click Add.
15. On the Data Explorer, click Close.
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Submittal Register Type 60.ttx
appears in the Subreport Expert.
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What do I do?

What happens?/Comments

16.

Click Next>>,

The Fields tab of the Subreport Expert
now appears:

17.

Select
LU_SubRegisterType~Description.

18.

Click Add->.

The field name moves to the Fields to
Display list.

19.

Click OK.

This is the only field you want to
display.
The Insert Subreport dialog returns.

20.

Click the Link tab.

Here you will designate the field in the
main report that will link to a field in
the subreport.

117

Advanced Reporting with Prolog Manager 6.0

What do I do?

What happens?/Comments

21. In the Available Fields list select
Select Submittal Register~TypeID .

22. Click the arrow button.
The field name is copied to the Field(s)
to link to list.

23. In the Select Data in subreport
based on field list, select
LU_SubRegisterType~TypeID.

24. Click OK.
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When you click OK, the subreport
appears as a “dragable box field”
labelled Register Type Report. It
seems to be “glued” to the cursor in
your Crystal Reports environment.
When you click, it drops.

Lesson 5 Creating Subreports

Task A.6 How Do I Format the Subreport?
What do I do?
1.

What happens?/Comments

Drag the subreport cell to the Details
row of the Crystal environment, and
drop right below the field labels that
already appear in that row.

If you drop any place else in the Crystal
environment, you can drag the box to
the indicated location. You can also
press CTRL+ARROW keys to move it
into place.

2.

Click the Register Type Subreport
tab.

The design layout of the subreport
appears in the Crystal environment:

3.

Drag the right-hand edge of the LUSubRegister~Type cell to the left
and drop at about 2 inches.

This sizes the cell to fit in the report.

4.

Right-click the Print Date field and
on the shortcut menu, click Delete.

This field is not necessary.
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What do I do?

What happens?/Comments

5.

Right-click on the column header in
the Report Header b row for
LU_SubRegistetType~Description,
and on the shortcut menu, click
Delete.

This label is not necessary here.

6.

In the Details row, right-click
LU_SubRegisterType~Description,
and on the shortcut menu click
Format Field.

The Format Editor appears:

7.

On the Comman tab, check Can
Grow.

This setting allows the test to wrap if
there is not enough room for it.

8.

On the Font tab, in the Font field,
select Arial (Western).

9.

In the Size field, select 8.

10. Click OK.
11. On the Register Type Subreport tab,
drag the right-hand edge of
LU_SubRegisterType~Description
field and drop so the cell fits in the
space indicated.
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What do I do?
12.

In the left-hand title column, rightclick Report Header b and on the
shortcut menu, click Hide.

13.

In the left-hand title column, rightclick Report Footer b and on the
shortcut menu, click Hide.

14.

Click Save.

15.

Click the Design tab.

16.

Right-click the cell of the Register
Type Subreport and on the submenu,
click Format Subreport.

17.

On the Font tab, in the Font field,
select Arial (Western).

18.

In the Size field, select 8.

19.

On the Border tab in the Line style
area, set all four sides to None.

20.

Click OK.

21.

In the Details row, drag the lowerright hand corner of the Register
Type Subreport cell and drop on a
size that will fit in the colum space
provided.

What happens?/Comments

The Format Editor returns.

When complete, your Crystal
environment appears as follows:
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What do I do?
22. In the Insert menu, click Formula

What happens?/Comments
The Field Explorer appears:

field.

23. Click New.

The Formula Name dialog appears:

24. In the Name field, type
lng.SubRegisterTypeDescription.

25. Click OK.

The Formula Editor opens to the new
field:

26. On the first line of the editing area,

This is a comment, describing the
process.

type: //Passed at runtime from
language database.
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What do I do?

What happens?/Comments

27.

On the second line of the editing
area, type “Type Desciption”.

Include the quotation marks. This tells
Crystal reports to use these words as
the label for this column.

28.

Click OK.

The Field Explorer now includes the
name of the new formula.

29.

Drag
lng.SubRegisterTypeDescription
and drop in an empty white space.

You want to format the title properly
before you put it into place.

30.

Size the field so it will fit in the
column above the subreport.

31.

Right-click on
lng.SubRegisterTypeDescription
and click Format field.

32.

On the Font tab in the Font tab, select
Arial (Western).

33.

In the Style field, select Bold.

34.

In the Size field, select 9.

35.

In the Color field, select White.

36.

Drag the field and drop in the black
row above the subreport field.

37.

Click Save.

You can use ctrl+arrow keys to
manuever the field into place.

123

Advanced Reporting with Prolog Manager 6.0

Task A.7 How Does a Subreport Appear in a Report?
Now you can run the rewly created report. The subreport appears as the appropriate column
in the report.

What do I do?
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1.

In the Report Manager, select
Submittal Packages [With Type
Description].

2.

The subreport appears as a new
column in the report, displaying the
Type.

What happens?/Comments

APPENDIX

Appendixes
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A p p e n d i x

A

TOOLBARS
Toolbars

This appendix references Prolog Manager toolbars. It provides an
illustration and description of each toolbar button and any
keyboard shortcuts for toolbar buttons. This appendix describes
the following toolbars:
Standard Toolbar
Form Buttons Toolbar
Word Processor Toolbar
Seagate Crystal Reports Preview Toolbar
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Standard Toolbar
The buttons on the Standard toolbar give you access to the most commonly used commands
in Prolog Manager, such as opening a project, checking spelling and printing reports. The
table below shows the Standard toolbar buttons, indicates keyboard shortcuts (if
applicable), and describes the function of each button.

Button
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Name

Keyboard
Shortcut

Function

Open Project

None

Opens the Select Project dialog from
which to select an existing project

Cut

CTRL+X

Cuts the selected text or object and
moves it to the clipboard

Copy

CTRL+C

Copies the selected text or object and
moves it to the clipboard

Paste

CTRL+V

Inserts the text or object from the
clipboard to the location of the
insertion point

Undo

None

Deletes the last action (only for word
processor functions)

Redo

None

Repeats the last action (only for word
processor functions)

Quick Text

None

Opens the Quick Text feature

QuickFilter

None

Opens the QuickFilter feature

Prolog Today

None

Opens the Prolog Today featur.

Calendar

CTRL+E

Opens the Calendar

Spelling
Checker

CTRL+S

Starts the Spelling Checker. This
button is available only when a form,
template, or document is open.

Appendix A: Toolbars

Button

Name

Keyboard
Shortcut

Function

Quick Print

CTRL+P

Opens Report Manager and selects a
report for printing, unless you have
changed your Printer destination
preference

Report
Manager

CTRL+R

Opens Report Manager

Query
Manager

None

Opens Query Manager

Companies
and Contacts

None

Opens the Company Setup form

Distribution
Lists

None

Opens the Distribution Lists form

Conversation
Log

None

Opens the Conversation Log form

Transmittal
and Courtesy
Copy Wizard

CTRL+T

Starts the Courtesy Copies (cc) Log
and Transmittal Queue Wizard

Quick
Transmittal

None

Opens the Transmittals and
Correspondence Log form

Create
Submittal
Transmittal

None

Opens the Submittal Transmittals
form and creates a submittal
transmittal for the active submittal
package. This button is only
available when the Submittal
Packages form is open.

Auto Alerts

None

Runs the Auto Alerts feature

Link to HotList

CTRL+H

Opens the Link to HotList form

Link to Issue

CTRL+I

Opens the Link to Issue form
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Button
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Name

Keyboard
Shortcut

Function

Link to
External File

None

Opens the Link External File dialog
box to link an external file to the
active recor.

Link to Lynx
Photo

None

Links a Lynx digital photo to a
record in Prolog Manager. This
button is displayed only if you have
installed and set up the Lynx
application to work with Prolog
Manager.

Link to MS
Word
Document

None

Creates a letter by merging a
Microsoft Word template with data
from the active record, and links the
newly created letter to the active
record

Link to PM
Writer
Document

None

Creates a letter by merging a PM
Writer template with data from the
active record, and links the newly
created letter to the active record

Link
Comments

None

Opens the Comments dialog box for
you to add new comments, or view or
respond to existing comments for a
record

Link Views

None

Opens the Link Views window

Create PCO

None

Opens the Potential Change Orders
form. If another form is open, Prolog
Manager creates a potential change
order with the data in the active
record.

Application
Launcher

CTRL+L

Opens the Application Launcher
dialog box to start other applications
without quitting Prolog Manager
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Form Buttons Toolbar
The command buttons on the Form Buttons toolbar are located at the bottom of each form
by default.

Form with buttons

If you choose to use the Form Buttons toolbar instead (in the Tools menu, click Toolbars,
and in the submenu, click Form Buttons toolbar), the toolbar allows you to add, save, or
delete a record, while saving space and giving you more room to view the form and enter
data. This toolbar can be either “docked” or “float” anywhere on your screen:

Form Buttons toolbar in use
Docked

Floating

The arrow/navigation buttons on this toolbar
provide a means to scroll
through a list of items which have been selected from a database.
The following table describes the keyboard shortcuts and functions of each button on the
Form Buttons toolbar.

Button

Name

Keyboard
Shortcut

Function

Add

ALT+A

Adds a new record in a form

Save

ALT+S

Saves the active record in a form

Delete

ALT+D

Deletes the active record in a form
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Button
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Name

Keyboard
Shortcut

Function

Refresh

ALT+R

Reverts to the last saved copy of the
active record. If you click Refresh in
a new, unsaved record, Prolog
Manager clears the form.

Close

ESC

Prompts you to save your changes to
the active record and then closes the
form

Cancel

ALT+C

Closes the active form without
saving any changes

First

F5

Retrieves the first record in a form

Previous

F6

Retrieves the previous record in a
form

Next

F7

Retrieves the next record in a form

Last

F8

Retrieves the last record in a form

Lookup

F9

Opens a list of all the records in a
form
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Word Processor Toolbar
The Word Processor toolbar can be used as a shortcut to many of the items on the Word
Processor menu. The Word Processor toolbar is only available when you are using PM
Writer. The following items are available on the toolbar:

Button

Name

Function

Quick Print

Prints the open document

Print Preview

Previews the open document

Delete All Documents

Deletes all documents

Delete Merge Field

Deletes selected merge field

Find

Finds text in a document

Replace

Finds and replaces text in a document

Page Break

Inserts a page break in the open
document

Insert Table

Inserts a table in the open document

Insert Merge Field

Inserts a merge field in the open
template. Merge fields can only be
inserted in templates.

Format Merge Field

Formats the selected merge field. Merge
fields can only be formatted in
templates.

Merge Field Sort Order

Opens the Set Merge Fields Sort Order
dialog box

Courtesy Copy (cc) List

Inserts a Courtesy Copy list into a
Microsoft Word or PM Writer
document
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Name

Function

Show/Hide Control
Characters

Displays or hides nonprinting characters
such as tabs, spaces, and paragraph
marks

Format

Accesses items in the Format menu

View

Accesses items in the View menu

Convert to MS Word

Converts the open PM Writer document
to Microsoft Word

Appendix A: Toolbars

Seagate Crystal Reports Preview Toolbar
The Seagate Crystal Reports Preview window contains a toolbar you can use to navigate
the report displayed in the window.

Button

Function
Closes the Print Preview window
Displays the first page of the report
Displays the previous page of the report
Displays the next page of the report
Displays the last page of the report
Stops running the report
Sends the report to the default printer
Opens the Print Setup dialog box
Refreshes the report data
Exports the report to a file
Switches the Group Tree view on/off in the Preview tab
Sets the magnification level for viewing the report
Searches for specific text in the report
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INDEX
Index

Symbols
.mdf file 4
.ttx file 58, 82, 108, 113
@@ 30

A
add
columns 58
user 38
associate .ttx file 62

C
change permissions 36
color usage in Report Manager 11
columns
adding 58
changing names 23
deleting 54
detail information 71
formuals 95
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formulas 75
headers 95
reposition 66
conventions vi
copy report 58
copying reports 16
course objectives vi
creating
.ttx file 60, 108, 113
new report 85
record filters 19–22, 27–30
report footers 24
reports from existing reports 16
subreport 106, 114
ttx file 82
Crystal environment 48
Crystal Reports 48
preferences 66
Crystal Reports designer 51

D
deleting columns 54
descending sort order 22
descriptions of reports 17
detail information, column 71

E
Enter values dialog 31

F
filtering reports 19–22, 27–30
footers, in reports 24
Form Buttons toolbar 6
formulas 75

G
group name, insert 90

H
headings
changing in reports 23
Help 7

I
installing report 103

L
logos in reports 24
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M
main window 4

N
new report 85
new user group 34

O
online Help 7

P
preferences
Crystal Reports 66

R
record filters
creating 19–22, 27–30
using @@ 30
renaming reports 17–18, 101
Report Manager
changing run-time value 23
color usage 11
column names 23
copying reports 16
creating record filters 19–22
creating reports 16
footers 24
logos 24
renaming reports 17–18
report descriptions 24
restricting access 41
run-time value 23
Security Manager 34
sorting records 22
system reports 12
reports
access 34
changing column names 23
copying 58
creating new 85
descriptions 17
displaying descriptions 24
filtering records 19–22
footers 24
installing 103
logos 24
modify for subreport 110
new 85
record filter values 31
renaming 101

Index

running 12
security 34
sorting records 22
titles and subtitles 17
repositioning columns 66
restrict access 41
running system reports 12
run-time record filters 27–30
run-time value, changing 23

S
Seagate Crystal Reports 48
Security Manager 34
sort order 22
sorting records 22
subreport
appearance in report 124
create 114
creating 106
format 119
how different from report 106
Switchboard 4, 5
system footers, displaying in reports 24
system reports, running 12

T
technical support 7
template 85
toolbars, form buttons 6
ttx file
associate 62, 87
create 60, 82, 108, 113
for subreport 108, 113
typographic conventions vi

U
user group 34, 38
permissions 36
user-defined report footers 24

V
Value column 30
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